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The National Institute of Standards and Technology (NIST) uses its best efforts to deliver a high-
quality copy of the Database and to verify that the data contained therein have been selected on the
basis of sound scientific judgment. However, NIST makes no warranties to that effect; and NIST shall
not be liable for any damage that may result from errors or omissions in the Database.

Use of any NIST Mass Spectral Database is limited to a single computer by a single user at any one
time. There is no restriction as to multiple copies in the same or multiple formats on the same single-
user computer or to backup copies which are for management purposes and not for use on any other
computer. In the event of an upgrade from a previous version of any Database, that previous version
of the Database may not be installed on another computer and used in the same time period as the
upgrade. The previous version may continue to be used on the same single-user computer on which
the upgrade is installed.

© 1987, 1988, 1990, 1992, 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2005, 2008, 2011,
2014, 2017 copyright by the U.S. Secretary of Commerce on behalf of the United States of America.
All Rights Reserved.

No part of this Database may be reproduced, stored in a retrieval system, or transmitted, in any form
or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior
written permission of the distributor. Portions of this program are also copyrighted by Microsoft Corp.

Microsoft is a registered trademark of Microsoft Corporation, and Windows is a trademark of Microsoft
Corporation. ISIS is a trademark of MDL Information Systems, Inc.

Portions copyright © 1984 - 1996 FairCom Corporation. "FairCom" and "c-tree Plus" are trademarks of
FairCom Corporation and are registered in the United States and other countries. All Rights Reserved.
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NIST MS Search and Lib2NIST software uses InChl Library v.1.05 (Copyright © IUPAC and InChl
Trust Limited, http://www.inchi-trust.org/download/105/LICENCE.pdf)

Certain trade names and company products are mentioned in the text to
specify adequately the computer products and equipment needed to use this
software. In no case does such identification imply endorsement by the
National Institute of Standards and Technology of these computer products
and equipment, nor does it imply that the products are necessarily the best
available for the purpose.
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Installation
Windows XP SP3, Windows Vista, Windows 7, 8, 8.1, 10

e Open Windows Explorer and navigate to the location of the NIST 17 installation. This may be a
folder or it may be a CD drive or a USB drive. run setup.exe from the CD.

¢ In the folder or on the drive which contains the NIST 17 install-software, highlight SETUP.EXE
and double-click the left Mouse button.

¢ Follow the instructions presented by the SETUP program.
In upgrading from a previous version of the NIST MS Library, there is a possibility to keep both

versions.! The Installer may behave differently under various versions of Windows due to User
Account Control security features.

1in upgrading from a previous version, the Database and Programs will be overwritten by default. To avoid this, (1) the Database should be
installed in a new folder, and (2) a new Program Folder should be created (selected) for the Start Programs shortcuts.

(1) To retain the previous version of the NIST MS Search Program and its associated Database, select No in the Question dialog box below.

x|

Setup Type

s

&

Select the setup twpe ta install, then click Mext.

Fleaze select a setup type.

=

P Setup has found previously installed components:

‘“‘r/ "MIST MS Search' and "AMDIS".
Click YES to ovensite previously installed components,
Click NO to install software to c:hnist] Pimasearchy and o bnist] Phamdis32s folders.
[Later pou will have an opportunity to change destination folderz]

Mo
M55 Library M5 Trterpreter
GC Method and RI Library Library Converter

< Back Mest > | Cancel

Question dialog box: Select overwriting the previous installation, or retain the previous
installation and install NIST 17 in a new folder.

(2) When the dialog box shown below appears, the name of the Program Folder must be changed to NIST 17 Mass Spectral Database. If this
is not done, the contents of the existing Program Folder, NIST Mass Spectral Database, will be overwritten, and the previous version of MS
Search and its Database will no longer be accessible from the Start menu.

x|

Select Program Folder i

L

Setup will add program icons to the Program Folder listed below. “vou may tepe a news folder
name, or select one from the existing folders list. Click Mext to continue.

Pleasze select a program folder.

Program Folder:

Ezisting Folders:

MSD ChemStation B
MIST 11 GC Rl Database

MIST 11 Mazs Spectral D atabaze

MIST 14 GC Method and Rl Database

MNIST 14 Mass Spectral D atabaze ]
MNIST 14 Tandem Library
MIST Mags Spectral Wileyl 0-Mist 14 D atabaze =

< Back Mest » | Cancel |

The name of the Program Folder must be changed if a previous version of MS Search and its
Database are to be retained.
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OS Compatibilities

NIST 17 and MS Search are NOT compatible with Windows 3.x, 95, 98, Me, NT 3.x, Windows NT 4.0,
Windows 2000, and Windows XP before SP3.

NIST 17 and MS Search are fully compatible with Windows XP SP3, Vista, Windows 7 (XP, Vista, and
Windows 7 in both 32- and 64-bit editions), Windows 8, and Windows 10*.

Also needed are:
e Adobe PDF reader to access the NIST 17 Manual

o WIinNT4Sp3+MSIE4.0/4.01/4.01SP1+hhupd.exe or WinNT4Sp6+MSIE4.01SP2 or later version
of IE to access NIST MS Search html Help

* |ssues with the custom scaling level feature of Windows 10 may have be observed. It is best to turn
the custom scaling level feature in Windows 10 off.
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Features in NIST 17 Library and the MS Search Program

NIST 17

The 2017 version of the NIST/EPA/NIH Mass Spectral Library (NIST 17) contains four mass spectral
libraries and a Library of retention index (RI)/GC Method. There are two El Libraries, mainlib and replib.
The number of compounds with GC Methods/RI Library in the EI MS Library (mainlib) is 72,361.

Contents of the NIST/EPA/NIH (NIST 17) Mass Spectral Library
Library . _ .
Name Library Description Library Contents
mainlib Main EI MS Library 267,376 spectra
. Replicate spectra
replib Library 39,246 spectra
. Tandem Library of small 574,826 Tandem spectra for
nist_msms )
- molecules 118,082 ions
. MS/MS Library of 90,244Tandem spectra for 6,803
nist_msms2 . . .
— commercial peptides ions
nist ri Retention Index/GC 404,045 records for 99,400
- Method Library compounds

Version 2.3 of the MS Search Program
Since Version 2.2, distributed with NIST 14, there have been a number of important features added.
These are summarized below.

For All Mass Spectra

¢ InChilKey presearch for all Library spectrum searches (finds all spectra, which have the same
first INnChlKey segment as the search spectrum, and compares them to the search spectrum)

e When a spectrum is associated with a structure in the Spectrum Information dialog box of the
Librarian tab view, the InChl Key is automatically associate with the spectrum.

e Columns in any Hit List can be positioned as desired.

o Update list of libraries may be performed without exiting MS Search

¢ Indexing old libraries for El Hybrid, El Loss, HiRes Any-peaks Peak and Loss searches, and
InChl presearch. This includes third party libraries like the Wiley Registry.

e A new version of MS Interpreter allowing for high accuracy mass spectra and exact masses for
fragment ions (More details later in this in manual)

For Electron lonization Mass Spectra (Low Resolution)
e A new EI Hybrid Search (Similarity/Hybrid).
e Presearch for El Similarity/Neutral Loss search

For Tandem (MS/MS) and High Resolution Mass Spectra
e HiRes MS/MS Hybrid Search
o Types of Any Peak search: HiRes peak and HiRes loss
e Display additional MS/MS information in hit lists
e Edit accurate peak m/z, intensities and peak annotations in the built-in mass spectrum editor
e MS/MS Precursor m/z search
e Precursor type constraint
e  Spectrum polarity filter

NIST 17 MS Database and MS Search Program v.2.3 Page 3



The following features were added to version 2.2, distributed with
NIST 14 as compared to ver. 2.0g, distributed with NIST 11 or with
NIST 12 Tandem library.

Features Relevant to Electron lonization Mass Spectra (Low Resolution)

Use of Retention Index in library searching: Deviation of experimental RI from the library value
optionally used to penalize the Match Factor.

Older user libraries with Rl values can be indexed to allow the RI values to be used in library
searching

Display RI values in a hit list column
Import, export, and edit compound RI value(s)
New definitions of derivatives are used for finding replicate spectra

Optionally display derivative precursor in the Lib. Search hit list

Features Relevant to All Mass Spectra

All small molecule mass spectra in NIST libraries have InChiKeys linked to PubChem (NIH).
These INChIKeys may also be used for searching compound information on the Web or for
exact structure searches within NIST libraries.

Set Prepend/Overwrite/Ask automatic mass spectrum import option.
Import and display Glycan structures in KEGG Chemical Function (KCF) format and add them
to user library mass spectra

Features Relevant to Tandem and High Resolution Mass Spectra

Display additional MS/MS information in hit lists
Edit accurate peak m/z, intensities and peak annotations in the built-in mass spectrum editor

o Import of ‘in-source/El with accurate m/z’ spectra, which do not include a defined m/z of
the precursor ion. To import these spectra, select “In-source /El (accurate m/z)" in
Spectrum Import Options.

o In-source/El with accurate m/z spectra have accurate ion peak m/z and intensities. The
accuracy is set in Spectrum Import Options.

o In-source/El with accurate m/z spectra may be searched in In-source/El with accurate m/z
and/or MS/MS library with the new In-source HiRes search (ion peak m/z tolerance down
to 0.015 ppm or 6x10° m/z units), Similarity Simple, Identity Normal or MS/MS Presearch
OFF search options. For this purpose, adding Reverse Search option may useful.

o In-source/El with accurate m/z spectra may be added to a user library. Currently, in-
source/El with accurate m/z spectra added with NIST MS Search to a user library may be
searched with In-source HiRes search only with Presearch OFF option. Rebuild the library
with Lib2NIST to get in-source HiRes search benefits?.

A new MS/MS search for small molecules

o Improved ability to identify compounds with a few dominant peaks —a common situation

for Tandem MS.
o More robust scoring for spectra acquired on imperfectly-tuned instruments

2 Library searchable with In-source HiRes search has files peak_em0.inu and peak_em0.dbu

Page 4
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e New Mass Spectrum Import Options

Control the number of decimal places in the input m/z

Set peak intensity threshold

Import in-source or El spectrum with accurate ion peak m/z and intensities.

Import MS/MS and in-source/El with accurate m/z spectra from JCAMP files (October
2012, nistms32.dll version 2.1.5.3 or later)

O O O O

GC Methods / Retention Indices Library

The GC Methods/Retention Indices library has been extended by including summary statistical
analysis of all data in the record. This information will be displayed in the spectrum text information
even if the Retention Indices box is unchecked in the properties box. The summary data are given in
terms of the type of column (standard non-polar(DB-1), semi-standard non-polar(DB-5), or
polar(carbowax)), the median value of the retention data for that column type, the deviation and the
number of experimental determinations. Note the deviation is calculated as the median absolute
deviation. In the example below (for 6,6-Dimethyl-2-methylenebicyclo[3.1.1]heptan-3-ol or pinocarveol
), there are 13 values for the DB5 series of data, 9 for the DB 1 and 12 for the polar column with
median absolute deviations of 4,7 and 8 respectively.

Experimental RI mediantdeviation (#data)
Semi-standard non-polar: 1138+4 (13)
Standard non-polar: 113547 (9)
Polar: 165448 (12)

The data will also optionally be shown in the hit list, and the column that will be shown is user
selectable.

The Retention Indices checkbox controls the display of the detailed experimental data. The number
of GC Methods/Retention Indices displayed is controlled by selecting All or First and entering the
number of values to be displayed. The default is to display the first two values. Displaying all values
will cause the display to be slow if there are a very large number of literature values.

In addition, for many compounds, an Estimated Kovats Retention Index will be displayed based on
the structure associated with the spectrum. These values are reported in index units (iu) with a
confidence interval; e.g., “Confidence interval (Ketones): 57(50%) 246(95%) iu” reported for acetone.
This means that there is a 50% probability the true value falls within 57 iu of the estimated value and
95% of the time the true value falls within 246 iu of the estimated value. The analysis is based on
error measurements of all the data for the class of the compound given; i.e., in this example, ketones.
These estimates only display if Retention Indices has been checked in the properties box. The
estimates are not displayed in hit lists. If spectra in a user library have associated structures, an
Estimated Kovats Rl may also be listed for these spectra if the calculation is possible.

The NIST Tandem Mass Spectral Library

Tandem (aka MS/MS or Product-ion) spectra, along with an increased number of fields relevant to
data obtained using MS/MS, are provided in a set of files separate from the Main and Replicates data
files that comprise the Library of El spectra. The Tandem spectra have been provided by contributors,
measured at NIST, and extracted from the literature. The preparation of the Tandem Spectra Library
revealed that at sufficiently high signal-to-noise measurement conditions, modern instruments can
provide very reproducible “library-searchable” spectra. Although collision energy is an important
variable in Q-tof and related instruments, spectra vary in an understandable way depending on the
compound and instrument type as well as collision-energy conditions. Energy-dependent variation is
NIST 17 MS Database and MS Search Program v.2.3 Page 5



accounted for by including spectra for most compounds over a wide range of collision energies,
ranging from slight to complete dissociation of the precursor ion.

The Tandem spectra in NIST 17, as in previous versions, are provided in two libraries, nist_ msms and
nist msms2. The nist_ msms library is described in detail below. The second MS/MS library,
nist._ msms2, contains spectra of compounds that do not have chemical structures displayed. They
mostly are commercially available peptides. Spectra from the nist_msms2 library are not displayed in
the MSMS tab. Otherwise, the format of the two libraries is similar.

The MSMS tab allows access to the spectra in the nist_msms library. The first time this tab is selected,
the three panes of the display are blank except for single entry in the ion list pane, which is on the left
of the tab’s display. This entry is the MS/MS Library. There is a box on the left that has a plus sign.
Placing the Mouse pointer on this box and clicking expands to the first two levels (Positive lons and
Negative lons). There are plus boxes next to both the Positive lon and the Negative lon. Clicking on
one of these plus boxes results in the display of the next level. This is a list of molecular weights of
analytes for which a spectrum was obtained by MS/MS. Clicking on the plus box next to one of these
molecular weight listings results in the display of a list of elemental compositions that will also have
plus boxes next to them. Clicking on one of the elemental composition plus boxes will result in a
display of a list of the compound names that have that elemental composition. In most cases, this is
only a single compound. Clicking on the plus box next to the compound name will result in the display
of a list of the spectra acquired under MS/MS conditions for this compound. If more than one spectrum
was acquired, there is a separate entry for each spectrum. Clicking on the spectrum entry will result in
displaying the spectrum information.

The listing of each spectrum begins with MS2.

& =lalx|
"IEle Search View Tools Options Window Help —|= ]
il =g =) ®
e MW=347 =
W MW=348 1004 351
e MW=349
5 MW=350 o]
& C13H26N405S N
+ Gly-Met(O)Lys
= Thr-Cys-Lys /\O
& Cys-Thr-Lys
5 C15H18N406 N "
= Trp(Dioxidation)}-Asn 501 280 94
& C17H26N404 308
322
% Phe-Gly-Lys =
Sz | 260
= Estrone sulfate J \\/ 222 236 250
& G1BH2GN205 0 45 70 84 93 112 130144458 1es 208 | | | |||\\ ol 03
C20H3005 T T — T t N T - T4 g N T
: C21H3404 60 90 120 150 180 210 240 270 300 330 - 360
o C22H2EN202 (nist_msms) Vinpocetine
&) Vinpocetine Name: Vinpocetine =
MS2; P 351.2067; CE 20 Formula: Co3HzgN202
MW: 350 Exact Mass: 350.199429 CAS# 42971-09-5 NIST# 1025948 |D#: 117365 DB: nist_msms
MS2; F 351.2057; CE 30 Other DBs. None
MS2. P 351 2067, O 40 g:)ersumrir;tr. N\SET ma{s:]fpectrometw Data Center
. Precursor type:
MS2; P 351.2067; CE 25 Spectrum type: MS2
MS2, P 351.2067, CE 28 Precursor m/z 351 2067
MS2; P 351 2067; CE 31 Instrument type: QqQ
MS2; P 351.2067; CE 35 Instrument: Micromass quattro
M52, P 351 2067, CE 41 Sample inlet: direct flow injection
MS2; P 351.2067; CE 45 lonization: ESI
MS2: P 351 2067: CE 50 In-source voltage: 40
MS2; P 351.2067; CE 56 gg”:ﬁgﬁ—;"‘[ -
av:
MS2; P 351 2067; CE 60 on mode. P
MS2; P 351 2067; CE 66 Notes: MeOHWater
NSZ, P 351.2067; CE 69 InChiKey: DDNCQMVWWZOMLN-UHFFFAQYSA-N =
MS2; P 351 2067; CE 77 10 largest peaks:
MS2; P 351.2067; CE 82 351 099.00| 280 460 19| 294 40583 | 308 36977 322 34049 |
MS2. P 351 2087, CE 91 266 202.32 | 323 150.861 236 124191 279 114101 222 75.031 =
vim 2t mnm ez [\ PlotText £ FL7
lb Search | OtherSearch |  MNames | Compam | Libmrian MSMS J
For Help. press F1

Figure 1. MSMS tab for data acquired using “triple quad”.
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& =101x]

"lHe Search View Tools Options Window Help -18] x|

HAEEE 7

- WW=210 = |
= 187

e MW=211 100

1 MW=212

e MW=213 NH

B MW=214

& MW=215 83 Cl
B MW=216 |
e MW=217 J 4
B MW=218

O H/

) MW=219 501
& MW=220

£ MW=221 104 A K
5 C10H11N30S |
5 C10HBCIN3O
= Chloridazon 116 142 159 \
5 MS2: P 222 0429 | | |
MS3; P 2220429, 187.074

#-CT11H15N302
#-C11HBCIND2 (

80 90 100 110 120 130 140 150 160 470 180 190 200
nist_msms) Chloridazon

#-C12H15N03 Name: Chloridazon B
+-C13H19ND2 Formula: C4gHgCIN30O
4-CBH15NOB MW: 221 Exact Mass: 221.035589 CAS#. 1698-60-8 NIST#. 1000453 ID# 112438 DB: nist_msms
T COH1BNO3S Other DBs' None
COHBCING Comment: Miriam Rittner, Zentrum fuer Umweltforschung und -technologie, University Bremen
+] -
MWez32 Precursor type: [M+H-CIl+.
S Specirum type. MS3
G- MW=223 Precursor miz: 222 0429, 187.074
i MW=224 Instrument type: IT/ion trap
& MW=225 Instrument: Bruker Esquire LC-MS
i MW=226 Sample inlet. direct flow injection
w-MW=227 lonization: ES|
1 MW=228 lon mode. P
MW=229 InChiKey: WYKYKTKDBLFHCY-UHFFFAOYSA-N
b WVY= o .
MW=230 largest peaks:
Eel- MV 187 999.00| 88 701.37| 188 207.73| 104 292.74| 186 194.82|
B MW=231 142 92.92| 159 77.93| 116 5805|
- WW=232 Synonyms:
& MW=233 1.3(2H)-Pyridazinone, 5-amino-4-chloro-2-phenyl-
B MW=234 2 4-Amino-5-Chioro-1-phenyl-6-pyridazone i
B MW=235 =l
it ane | [ ProtText A TR
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Figure 2. MSMS tab for data acquired using “ion trap MS3”.

For beam-type instruments (e.g., triple quadrupoles, HCD, and Q-tof instruments), the MS2
designation refers to spectra generated by dissociation in a collision cell of a selected precursor ion.
For ion trap instruments, the MS2 designation refers to dissociation in the trap after following the
isolation of the precursor ion.

In the case of data acquired using an ion trap mass spectrometer, the MS2 may have a plus box next
to it. Clicking on this plus box results in a subsequent spectrum listed as MS3, which may also have a
plus box. Selection of the plus box next to the MS3 spectrum can result in an MS4 spectrum, which is
obtained by the isolation of a product ion as a precursor ion for a subsequent iteration of MS/MS.

Clicking on the MS3 results in the display of the spectrum as seen in Figure 2. The MS2 designation is
followed with the precursor ion m/z value and the collision energy for beam-type instruments (Figure 1).

As can be seen from Figure 1 and Figure 2, there is a great deal more information provided in a text
format for the spectra in the nist_msms library.

The Tandem Library can be searched with any of the Other Searches or the Incremental Name
Search. All that is necessary is to include the nist_msms library in the Include Libs column of the
Search dialog box for the Other Searches or as the single library to be searched in the Incremental
Name Search. The Library Spectrum Search and Structure Similarity Search are also applicable.
However, the user must understand that Tandem spectra in general are different from EI spectra as
well as the fact that structures in the MS/MS Library refer to the neutral form of the precursor ions.

If the nist_msms library is not present, the MSMS tab is not displayed.
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Software Changes from earlier versions of the Search Program

Version 2.0g of the MS Search Program

Below is a list of features new to the previous version, 2.0g, which was distributed with NIST 11.

A new Exact Mass Search allows searching for exact mass of a precursor (exact molecular
weigh) using its mass or exact m/z of a product ion. It takes into account the presence or
absence of an electron, adducts or losses; accepts uncertainty in ppm or millimass units; and
allows searching for isotopic or monoisotopic peaks.

A new Exact Mass Constraint similar to Exact Mass Search.

Ability to use accurate mass to search exact fragment ion mass values in NIST libraries mainlib,
replib, and nist_msms using the Any Peaks Search.

Display of the exact mass with any spectrum that has an associated chemical formula.

Manage and search as many as 127 separate MS libraries instead of 16, which was the limit in
previous versions.

Optional display of columns in Hit Lists containing the number of synonyms and the number of
Other Databases in which the Hit appears. The Hit List can be sorted according to the values in
these columns.

Full compatibility with most recent NIST Peptide MS/MS Libraries.

Copy selected lines from Hit List or Spec List into Windows Clipboard as tab-delimited Unicode
text; this may be conveniently pasted into Excel.

Spectra in the MSP text format can be imported from the Windows Clipboard into the Spec List
via a Right Mouse button (RMB) menu option.

Searching for words in mass spectrum Text Information Window.
Optional exclusion of Homologues from the results of Structure Similarity Search.
Import spectra from mzXML and mzData files.

Multiple CAS Registry numbers for a spectrum. A small fraction of spectra in NIST 14 has more
than one CASrn. Each CASrn may be used in a CASrn Search.

The MS Interpreter program now enables high mass accuracy for both molecular ions and
product ions.

An alternative peak matching method to improve the reliability of the score when searching
noisy MS/MS spectra.

Several convenience features.3

Version 2.0f of the MS Search Program

Below is a list of features new to the previous version, 2.0f, which was distributed with NIST 08.

A new spectrum search for MS/MS spectra in MS/MS libraries, including the NIST MS/MS
libraries.

Spectra of stereo isomers, tautomers, and derivatives are displayed as replicate spectra.

3 New convenience features added to version 2.0g included:

Default view of Constraints and Other Searches dialog boxes changed to provide more convenience to the users.
Ability to Sort the Spec List alphabetically, by number of synonyms, by number of other databases.

Toggle between Tab views (Lib. Search, Other Search, Name, Compare, Librarian, and MSMS Windows) using
Crtl-Tab or Ctrl-Shift-Tab.

When a Tag from the “Comment” field is displayed separately, its display in the “Comment” field is suppressed.
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e Tags (which can act as Field Names) can be entered into the “Comments” field of a user library
along with the Field’s contents.

e Hit List can be sorted alphabetically.

e Five new Constraints have been added: Tags in Comment, Peptide Sequences, Peptide
Mobile Protons, Peptide Charge, and Peptide Number of Residues. Tags in Comment
Constraint, for example, allows searching for the name of the contributor in the EI Library.

e A search for information in the "Contributor/Comment” field, which may be particularly useful for
certain types of information relevant to MS/MS.

e Flexibility has been added to searches using a “Name Fragment in Constraints”. It is now
possible to specify the presence or absence of any arbitrary part or parts of a name.

e The Program does not use or require the installation of special NIST fonts.
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Guide to the Program

The Program uses tab displays. The tabs:

Lib. Search, Other Search, Names, Compare, Librarian, and MSMS tabs
which are located at the bottom of the Main Window. Selecting a tab results in the display of
a different Window. All tab displays have moveable divider bars (splitters), some of which can
be re-orientated as well as tabs associated with various panes (windows) within a view.
Selecting Window / Tile Vertically or Window / Tile Horizontally from the main menu displays

all windows.

Lib. Search tab (Figure 3) is used for all searches based on comparison of spectra or structures to a
library.

Other Search tab is used for most non-spectral searches, i.e. CAS number, Molecular Weight,
Formula, etc.

Names (Incremental Name Search) tab allows you to type in a name and have the program match
the name as you type. This search uses all names and synonyms in the specified library

Compare tab allows for easy comparison between spectra. It is, by default, automatically refreshed
with the latest spectral search of the library. You can put your own spectra into also.

Librarian tab keeps a history of the recent spectral searches and also can be used for import, editing
and user library construction.

MSMS tab gives you access to all the MS/MS data by molecular weight, formula, compound and
precursor ion for both positive and negative ions.

In every window, properties of the pane may be controlled using the Right Mouse Button (RMB) to
bring up a menu from which the context sensitive properties box may be accessed. Alternate layouts
can be selected using the Change layout button E3 in the Tool Bar which is just under the Main
Menu. A Tool Tip (the name of a button) is displayed when the Mouse pointer is placed over a Tool

Bar button. There is also a Tool Bar button to restore the default layout = (Set default layout).
Alternatively, Default Layout and Change Layout in the Window menu may be used.

All the tab displays have the same Main Menu. The various menu selections available for each of
these tabs are described in more detail throughout the manual. The File menu has Save
Configuration and Restore Configuration selections which allows all the various tab display
configurations to be saved to a specific file name and then recalled. Multiple users may have different
ways of configuring each tab that is best for them. This way, each one can restore a specific set of
display options. This does not include data search history. There is no change in the search history
or Spec List resulting from a Restore Configuration.

The Search selection on the Main Menu allows for quick selection of non-spectral type search.
Depending on the choice the selection will transfer you to the correct tab and bring up the options for
that search.

The View option on the Main Menu (top of Figure 3) allows the display of the Tool Bar and/or the
Status Bar (bottom portion of Figure 3 containing For Help press F1 and Ident). There are also
options to turn off the display of the Compare pane in the Lib. Search and Compare tab views.

Tab displays can be brought into focus by placing the Mouse pointer on the tab name at the bottom of
the desktop and clicking the left Mouse button. It is also possible to switch between tab views using
the hot keys Ctrl-Tab and Ctrl-Shift-Tab.

Many of the controls for individual window are similar from tab to tab. These are covered in detail for
the Library Search Tab but apply for most of the tabs.
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The Lib. Search Tab

The first tab (lower left of the Program’s display), Lib. Search, is used with a search of a spectrum or
structure against mass spectral libraries: a user library and/or the NIST 17 Libraries (Figure 3). The
spectrum and structure searches can be done against multiple libraries (maximum of 127), and the
selected libraries can be different from those selected for the various searches found in the Other
Search tab. Spectra can be imported into the Spec List from linked mass spectral data systems
software, text files containing one or more spectra in the NIST format, or from the Windows Clipboard.
Structures in a MOL file format can be pasted into the Spec List for searching from the Windows
Clipboard or an ACSII file.

The top pane on the left side of the Lib. Search tab is Spec List (known as the Clipboard Window in
previous versions of the Program). The middle pane is a Hit Histogram, showing the distribution of
Hits according to the Match Factor values. This Histogram can be displayed with either a linear or log
scale on the y axis. The lower left pane contains the Hit List at the bottom. By default, the columns
for the number of synonyms, presence in other databases and retention index are not displayed.

On the right side of the movable vertical divider bar are three separate Windows: Search
Spectrum/Spec List Spectrum, top; Compare, middle; and Hit List Spectrum, bottom. There are
vertical divider bars associated with Spectrum/Text tabs of the top and bottom panes. By selecting
View from the Main Menu Bar, the display of the Compare pane can be deselected, it may also be
minimized using the splitter bars. If the Mouse pointer is in the Search Spectrum/Spec List
Spectrum Window or the Hit List Spectrum pane, the RMB (Right Mouse Button) menu option
Change Splitter Orientation can be used to change the orientation (back and forth between vertical
and horizontal) of the divider bar between the plot of and text information for the spectrum. In all
cases the RMB can be used to access the properties dialog box for each pane within the window.

The pane on the top left of the Lib. Search tab is used for the Spec List, and the pane on the lower
left of this Window is used for the Hit List. Note that both the top pane and the bar graph of match
factors can be minimized using the splitter bars to maximize the hit list space. The pane on the left of
the Other Search and Names tabs is used for the Hit List, and the pane in this position on the
Librarian and MSMS tabs is a list of spectra that can be displayed. It is important to know that the
Spec List in the Lib. Search tab and the Spec List in the Librarian tab are the same list. Spectra
may be copied to the Spec List, edited, and deleted from it. The Hit Lists are read-only. All of these
lists can be displayed as text or as graphic structures by selecting the Names or Structures tab at the
bottom of the pane, except for the MSMS tab which does not have this alternate display option. Note,
only name, match factor, reverse match factor and probability of correct hit are displayed in the
graphic mode.

Each Hit List (except the one in the Names tab) and the Spec List can be sorted alphabetically by
clicking on the Name Bar at the top of the pane. The Hit Lists in the Lib. Search tab and the Other
Search tab have optionally displayed columns showing the number of synonyms, the number of other
databases containing the compound and the retention index. These Hit Lists can also be sorted by
these columns by pointing to the column header and clicking the left Mouse button.

To copy lines selected in a Hit List or Spec. List into Windows Clipboard in tab-separated text format,
press Ctrl+K keyboard keys.
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Figure 3. Lib. Search tab.

In some cases, the Hit Lists will also have a plus box in front of the Hit number This symbol means
that there are replicate spectra for that Hit. Placing the Mouse pointer on the plus box and clicking the
left Mouse button will cause a list of the replicates to appear below the Hit. Some of the names of the
replicates will be preceded by R or an M, and some by m or r. If an R or M precedes the name, the
spectrum is of the same compound as the Hit and is in the NIST replib Library or the NIST mainlib
Library. If the name is preceded by an m or and r it means that the replicate is a derivative or isomer
of the Hit, with m being a spectrum in the NIST mainlib and r being a spectrum in the NIST replib.

The display of spectra of derivatives and isomers as replicates of a
compound is controlled through the Replicates Display Options
dialog box selected from Options/Replicates using the Main Menu
(Figure 4). Details are found by clicking on the Help button. ¥  Isctope

Selecting View/Derivative Precursor menu opens Show Derivative | e
IV Derivatives

Precursor for dialog box (Figure 5). Selecting derivative type(s) , Hep
affects Lib. Search hit list: structures of derivative precursors are

displayed instead of derivatives. Only mainlib and replib hits are Figure 4.
affected. Deselecting displayed derivative type(s) immediately changes structure display back to
derivative. See MS Search help topic "Show Derivative Precursor” for more details.

The Spectral Plot presentation pane (upper right of the Window in the default display) of all tab views
except the Compare tab, have settable attributes that are found in the Properties dialog box
described below. By default, the Plot pane displays the primary name of the spectrum in the lower left
hand corner of the pane. In addition, the library from which the spectrum was drawn precedes the
name in parenthesis. Optionally, the compound’s Molecular Weight (nominal mass), CAS registry
number, and Formula (elemental composition) can be displayed. This legend display can be forced to
wrap so that all characters will be visible (Figure 6). Also, optional, a structure (if associated with the
spectrum) can be displayed on the spectrum. If a structure has been requested and one is not
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assorted with the spectrum, a colored ? will appear. Labeling of the peaks is either by default or the
Plot tab of the Properties dialog box has a “Label peaks greater than (%)” option followed by a text
entry box allowing for the input of a number. If the spectrum is to be displayed without peak labeling,
enter 100 in this box or deselect m/z Label and Text Label options. It is also possible to use this
Properties dialog box to change the colors of the mass spectral peaks, scale, labels, bonds and rings
in structures, atomic symbols in structures, and the spectrum’s background. Selecting the Set default
layout button on the Tool Bar will restore colors to the original values.

W Silgation W Dximation F Other mondendate derivatizatior
= TMS (irimethylsi] = MO (methylosime) & Dansyl
© TEDMS [tert butpldimethylsi] ' EH0X [ethylasime)  Pyrolidide

" Benzli (benzylosime) £ Pipeiidide

I7fectialey 7 Bidentate defivatization

& TFA [hifluoroacetate] & MeBoronate (methylboraante)
" PFP [pentafluoropropionate] " EtBoronate [ethylboroante)
" HFE [heptafluarobutyiate] " BuBoronate [ butlboroante)
 Acetate " DMOX [dimethyloxazoline)
" Benzoate " Acetonide

" FFB [pentafluombenzoate] " Benzylidens

3 Cancel ‘ Help ‘

Figure 5. Select anyone of the five Derivative type check boxes;

then select the subcategory radio button.
The Text Info pane, by default, is to the right of the Spectral Plot presentation in the Lib. Search tab.
This orientation can be changed so that the Text Info pane is just below the Plot presentation by
using the RMB menu selection Change Splitter Orientation. In the other tab views where both the
plot of the spectrum and the text information are displayed, these two panes are oriented by default
with the Plot pane above the Text Info pane. Again, this orientation can be changed using the
appropriate selection on the RMB menu when the Mouse pointer is on either of the two panes. The
Hit Text Info tab (Text Info tab in some tab views) of the Properties dialog box has a number of
selectable display options in the form of check boxes (Compound Information, m/z intensity list,
Ten Largest Peaks, Synonyms, and Retention Indices). The Compound Information is: the
primary name associated with the spectrum in its source library; the Formula (elemental composition);
MW (nominal mass); Exact Mass (if there is an elemental composition associated with the spectrum);
CAS registry number; NIST Number (sequential number assigned to spectra in the NIST EI Archive);
ID number (position in the library containing the spectrum); name of the library containing the
spectrum; names of Other databases in which the compound can be found, if any (displayed only with
mainlib and replib spectra); Contributor (NIST Library)/Comments (user libraries); and Related CAS
registry numbers, if any (NIST DB only). The other check boxes of these first four selections are self-
explanatory.

If Retention Indices is checked and there are records containing literature GC methods and
Retention Indices, these records will be displayed following the display of synonyms (if selected). As
pointed out earlier, by default, only the first two records are displayed. If there are more than two
records, <...> will appear just below the last line of the bottom record. The Properties dialog box
allows the setting for the display of a larger selected number of records or all of the records. The
record is searchable using the Find selection on the RMB menu when displayed in a Text Info pane.
All text is searched so column types, active phases, authors or text in the article titles can be
searched. Only the records displayed are searched (Figure 7).
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Figure 6. The Spectral Plot display of a spectrum in the Name tab with the nominal mass, CAS registry
number, elemental composition name of the library containing the spectrum, and the name associated
with the spectrum. The display is wrapped, the structure is shown, and the peaks are not labeled.
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Figure 7. The Text Info display with Compound Information and Retention Indices as the only selected

display options.

It should be noted that the GC Methods/RI Library is also available separate from NIST 17 with its own
Search program, which allows for more extensive use of this Library.
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At the top left of the Lib. Search tab view (Figure 3) is the Button Bar. The meaning of each of these

buttons is shown below:

@)|%s| | 52| [1-ScanNo. 35 DEMO -®| (@] ala|

Library search Clear J f
options history View
History sub-

Import ' Replicates
Structure search list Off/On tsljl;léc
Library Spectrum Search Best matching only identifi-
View hitlist search options cation

Figure 9. Lib. Search’s Button Bar.

The Go button will launch a search of the highlighted spectrum in the Spec List. The Structure
Search button will perform a structure similarity search of the highlighted structure in the Spec List.
The Import button (with the file folder icon) is used to import spectra from a text file. The Library
Search Options button is used to display the dialog box used in selecting libraries to be searched,
search types, and other factors associated with the search of spectra and structures.

The drop-down list box contains the Search History. A previous search’s display can be restored by
highlighting an entry in this list. NOTE: the Program can be set to automatically clear the Hit List
and/or the Spec List by selecting the Clear History on Exit check box in the Hit List tab and/or
Plot/Text of the Spec List tab in the Library Search Properties dialog box displayed by selecting
Properties from the RMB menu.

The Clear History button is used to clear the search history. The Replicates On/Off button will
toggle the listing of replicate spectra on and off when the mainlib Library of the NIST/EPA/NIH
Library is searched.
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The Best matching only button will force the hit list to display only the hit with the highest match
factor for any given CASrn. This is the. This feature is especially useful when more than one library is
being searched, and some of the spectra in these libraries have the same CASrn’s associated with
them. In the case of an MS/MS Search, the best matching spectrum is selected out of Hits that have
the same CASrn or names and charge.

The View hit list search options button will result in the display of a dialog box with two tabs if
constraints have been used in the search. The Search or Options tab (depending on whether the Hit
List Search Options are for a Lib. Search or an Other Search carried out) lists the libraries
searched (and type of Search and Search Options for Library spectrum Searches only). The
Constraints tab (if present) lists all different constraints along with values used in the search (Figure
10 and Figure 11).

It should be noted that even though a Library spectrum Search is carried out against a list of libraries
(Figure 28) that does not include mainlib and replib, these two libraries will be listed as having been
included (Figure 11) as long as the Display InChl Replicates check box is selected in the Replicates
Display Options dialog box (see Figure 4). This will result in the display of the symbol indicating
replicates were found when the user-only library was searched. This means that InChl search options
are available for those spectra in libraries like the Wiley Registry of Mass Spectra and various other
libraries provided by Wiley and Others in the NIST format, which have CASrn present in mainlib.

x| Hitlist See x|
Options Constraints I Search I Constraints
S h T
Name Fragment : PHENYL il L
Precursor m/z from Oto 2000 Identity : Normal
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Type m/z From To Search Options
N 79 1 50 Presearch default
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| Mode: Absolute
Other databases Elements Library Involved
————————— | | Allowed number Al of mainib
?gEA of atoms these replib
EINECS B > 3 [c
H
Br
(0]
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Figure 11. List of libraries used in a Library spectrum

Figure 10. List of Constraints used for a specific . .
1gu ! I . pectt Search along with the Search Options

search along with their values.

Two other Important Points about the use of Constraints:

When a Constrained Search is carried out, the Search is performed as if there was no constraint. Only
the spectra that were found in the Search that fall within the constraint criteria appear in the Hit List.

The number of different constraints that are available exceeds the display area; a slider bar on the
right side of the Constraints Window in the Search dialog box allows access to all constraints. The
Constraint Window will only allow for the display of six constraint options at a time. Once values have
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been entered for any of these options, those values will remain until individually changed or deleted.
Once an available Constraint has been selected (check mark in check box entered by putting the
Mouse pointer on the check box and clicking the left Mouse button), the values previously entered for
that constraint will be used when a Constrained Search is performed. Because if a Constraint is
selected and is not visible in the Window, a bad result may occur, the program displays the number of
constraints selected. A Clear All button has been added to the Constraints tab of the Search dialog
box. The Clear All button removes the checks in the various constrains, it does not change the values
in each of the constraints. It is recommended to click on this button before starting a new Constrained
Search and reselecting any desired Constraints. Whenever any Constraint is selected, the Use
Constraints check box is automatically selected. Clicking on any individual Constraint’'s check box in
the Constraints Window causes appearance of the Constraints tab of the Search dialog box to
change to allow for the entry (or edit) of values for that Constraint at the same time the Constraint is
selected or deselected. The appearance can also be changed to that for a specific constraint by
clicking on the constraint description away from the check box.

The last button on the right, the View substructure information button, displays the Substructure
Information dialog box. The Substructure Information dialog box contains a list of the probability of
the presence and absence of substructures that may be associated with a compound that produced
the searched mass spectrum along with additional predictions about this compound’s molecular weight
and estimate of the numbers of atoms of chlorine and/or bromine that may be contained. This is
especially useful with a Neutral Loss, Hybrid Neutral Loss Similarity, or MS/MS In EI Similarity
Search. An example of the use of Substructure Information resulting from an MS/MS in El
Similarity Search of the El Library is provided later in this manual.

Title Bar, Tool Bar, and Status Bar

At the top of the display of each of the Program’s tab is a Title Bar. The contents of a title bar of the
active tab are also displayed in the Title Bar of the Program Window. When the Lib. Search or Other
Search tab is displayed, this Title Bar will contain information about the currently displayed search. In
the case of a Library spectrum Search, this will include the search type used, whether or not
constraints were used, and if any type of limits were applied to the search. In the case of the Other
Search tab, the Title Bar will contain the type of search that was done (i.e., Formula, Molecular
weight, Any peaks, etc.) and whether or not constraints were used. When the Compare tab is
displayed, the Title Bar contains the number of spectra available for comparison regardless of the
number displayed.

At the bottom of the Program’s display, below the Program’s tabs, is the optionally displayed Status
Bar. The Status Bar’s display can be turned off by selecting or deselecting Status Bar from the View
menu. When a Library spectrum Search is being conducted, the left side of the Status Bar will have
displayed “Comparing XXX Library spectra with submitted spectrum” where XXX is the number of
spectra that were found during the Presearch (see Search Algorithms in Appendix 5). If Off has been
selected in the Presearch area of the Search tab of the Library Search Options dialog box, XXX will
represent the total number of spectra in the libraries being searched.

There are five fields on the right side of the Status Bar. The left-most of these five fields will have
displayed the selected search type in the “Spectrum Search Type” area of the Search tab of the
Library Search Options dialog box (Neutral Loss, Hybrid, or Simple if the Similarity Search is
selected; and Quick or Ident depending on whether a Quick or Normal Identity Search has been
selected).

The next four fields to the right of the box indicating the selected search type pertain to the currently
displayed search results. The first box to the right contains the type of search that was used in the
displayed search results. The next box to the right will have contained “Rev” if the Hit List is sorted
according to the Reverse Match value (the Match Factor obtained by ignoring all peaks that are in the
sample spectrum but not the library spectrum). To set this mode, select Reverse Search check box in
the “Spectrum Search Options” section of the Search tab of the Library Search Options dialog box.
The third box will contain the number used as a precursor MW value in a Neutral Loss or Hybrid
Similarity Search. If an Identity Search has been carried out, the fourth box will contain “Penalize” if
the Penalize rare compounds check box was selected in the “Spectrum Search Options” section of
the Search tab of the Library Search Options dialog box.
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The Tool Bar’s display (Figure 12) is optional by selecting it from the View menu. The functionality of
its button Switch to Caller and Print Report is also available on the File menu; MS Interpreter, and
AMDIS also may be launched from the Tools menu.

H%%EQEI%EMh?

Cutj 1 L t About
Copy — Switch to Caller

Paste m/z range

Print Report Change layout

MS Interpreter — Set default layout
AMDIS

Figure 12. NIST MS Search Tool Bar.

A Tool Tip is associated with each of the buttons with an explanation of the button’s function. The =

button will return all displays on the currently viewed tab to the default values. The Ed button toggles
through three separate views for the currently displayed Program’s tab.

The m/z range button displays a dialog box (Figure 13) to fix the starting and ending m/z values for
bar-graph spectra displays, and to choose whether the peaks should be labeled with neutral losses or
with their m/z value.

An explanation of each of the items in this dialog box can be found by selecting the dialog box’s Help
button. The Anchors dialog box is used when viewing spectra with a neutral loss label. Selecting
Anchors will result in the display of the Anchors dialog box, which is explained by selecting the Help
button in that dialog box.

The two radio buttons at the top of this dialog box have to do with labeling spectra normally or
with natural loss values. Normal display is the most common.

Neutral Loss Display

" Scale as search/spec list spectrum

™ Secale as hitlist spectrum

™ Mindrmax of both spectra

= Fixed haxloss |70 bax myz [10

Anchors
Ok | Cancel | Helg ‘

Figure 13. m/z range (for Spectra Display) dialog box.

One of the important tools in deducing a structure from a mass spectrum is to look at the mass
spectral peaks as losses from the molecular ion rather than as individual peaks. In this way of viewing
the mass spectrum, the peak at m/z 269 in methyl stearate becomes the [M — 29]* peak (loss of an
ethyl radical) and the peak at m/z 267 becomes the [M — 31]* peak (loss of a methoxy radical). See

Figure 14.
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The program can display a spectrum with neutral loss labeling with the library spectra and search
spectrum be labeled as neutral losses with the first label on the right-most peak being 0 (Figure 15).
To activate this display, select Neutral Loss Display from the RMB menu. Selecting Neutral Loss
Anchors is explained in the Help files (topic m/z range). NOTE: If you do not know the molecular
weight of the search spectrum, the program will attempt to estimate it. This value may be overridden
by using the librarian to edit the spectrum and specifying a molecular weight and then using the edited
spectrum to run the library search.

@|3s| | 52| [1 Methyl stearate j@l L@ ala
1004 7
87
50
43 g5
143
298
83| g7 129 199 255
29 ‘ 185 267
0 15‘ i u“l Wl ‘n‘n\ "'.l 11|1\ " " 1?? m ol |I 213‘227 2:\” b A
20 40 80 80 100 120 140 160 180 200 220 240 260 280 300

PlotiText of Search Sp

(mainlib) Methyl stearate )

74
100H
87 o
50 /W\/\N\/\/\)LO/
43 gp
143
298
83| g7 129 199 285
29 267
0 15‘ - u‘\‘l w‘d ‘n‘n\ "'.l 11|1\‘ L . 1?? LA ‘”135 L 2113‘227 2;” i l‘
20 40 60 80 100 120 140 160 180 200 220 240 260 280 300
(mainlib) Methyl stearate
PlotText of Hit £_Flot o At 7
1 Lib. Search |Other5aa'eh| Names | Compare | Librarian | MSMS |

Figure 14. Nominal spectrum labeling where the top spectrum is of an unknown compound and bottom

spectrum is of the first Hit from a search of the NIST/EPA/NIH Mass Spectral Library (NIST 17).
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Figure 15. Neutral Loss spectrum labeling where the top spectrum is of an unknown compound and
bottom spectrum is of the first Hit from a search of the NIST/EPA/NIH Mass Spectral Library (NIST 17).
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The Other Search Tab

The second tab display, Other Search (Figure 16), is used to perform a MW (Nominal Mass), Exact
Mass, MS/MS Precursor m/z (NEW in v.2.3), Formula (elemental composition), Any Peaks,
Sequential Method, CAS registry number, NIST Number, or ID Number Search. The NIST
Number Search can only be carried out on the NIST Main Library (mainlib), the Replicates Library
(replib), the Tandem Spectrum Library (nist_msms) library and the Retention Index Library
(nist_ri). NIST Numbers establish correspondence between spectra in different releases of the
NIST/EPA/NIH MS Library and can be carried out on one or all of these libraries at a time. The ID
Number Search can only be carried out on one library at a time and can be used with any of the NIST
libraries or other libraries such as User Libraries. The MS/MS Precursor m/z Search works with the
NIST Tandem libraries and user libraries containing Tandem spectra. The other options in this group
can search multiple libraries (maximum of 127), and different sets of libraries can be specified for each
different type of search.

As shown in Figure 17, a new feature in v.2.2 of the Program was the display of columns showing not
only the number of synonyms, the number of other databases (non-mass spectral databases) in which
the Hit can be found but also the retention index (RI) if available. Not only are these columns available
for the Hit List of searches performed in the Other tab, but also in the Hit List displayed in the Lib.
Search tab. The display of these columns is controlled by the Hit List tab of the Properties dialog
box displayed by selecting the Properties option from the RMB menu displayed when the Mouse
pointer is in a Hit List pane.
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Hit List
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Figure 16. Other Search tab.
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Figure 17. Results of a Formula Search showing the number of “synonyms” for the Hits, the number of
other “databases” in which the Hits can be found and the RI value (if present) columns.
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The Names Tab

The third tab, Names, is used for the NIST signature Incremental Name Search (Names) (Figure
18). The Name Search can only be performed against one mass spectral library at a time. The
library to be searched is selected by use of the Library to search drop-down list box next to the a—z
button. If the a—z button is selected, the only input in the text entry field on far left just below the
button bar that will be taken is that of letters a—z. If the a—z button has not been selected, numbers as
well as letters can be input. Names containing Greek alphabet characters can be pasted into the text
entry field. Typed dashes and other punctuation characters will not be used. All letters are entered as
upper case regardless of the input.

NOTE: The drop-down list box just to the right of the a—z button is used to select the library to be
searched. This search method allows for the browsing of user libraries.

The second list box only appears when the library selected is one of the NIST mainlib is searched. It is
used to display replicate spectra for the NIST 17 mainlib Library. If there are no replicate spectra for
the highlighted selection in the Hit List, this list box will not appear on the display. When Replicates
are available they will appear in the list box as either Replicate followed by a sequence number or
*Replicate. Replicate is a spectrum of the same compound that is in the replib Library. *Replicate,
identifies a spectrum that is of a heavy isotope variant of the compound, a stereoisomer of the
compound, or a compound, which has the same derivative precursor.

The Name Search used with the NIST/EPA/NIH Mass Spectral Library uses not only the main name
but also any synonyms. As an example, the mainlib compound name for acetylsalicylic acid is the
common name Aspirin. This compound has 157 synonyms and its spectrum can be displayed by
entering any of these names including trade names like Bayer (Figure 18).
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Figure 18. Incremental Name Search tab.

Note, the use of synonyms is also supported in user libraries. Thus, if a spectrum is given a synonym
“Lab Book 4-PG-22”, then the data can be retrieved by that name using the incremental search.
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The Compare Tab

The fourth tab, Compare (Figure 19), allows the display of a sample spectrum and multiple spectra
from the Hit List. Other spectra can also be put into the Compare display. A selected spectrum in
the lower part of the Compare tab can be displayed as various types of comparisons with the
spectrum in the upper part of the display by selection of one of the tabs in the Compare pane
(Difference, Head-to-Tail, Side-by-Side, Subtraction).
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Figure 19. Compare tab.

The Librarian Tab

The fifth tab, Librarian (not shown), is used to deal with spectra that are in user libraries or that are to
be added to user libraries, or have been imported or searched. The layout of this tab is the same as
the tab used for the Incremental Name Search with the exception that the far-left pane contains the
Spec List rather than a Hit List. This is the same Spec List as displayed in the upper left pane of the
Lib. Search tab. The Librarian tab allows for the editing or creating of spectra. This editing not only
allows m/z intensity pairs to be edited, deleted, or added; but also allows CAS registry numbers,
elemental compositions, structures, names, synonyms, and structures to be edited, added, or deleted.
In addition, detailed text information about the spectrum can be added using a predefined set of tags.

When a splitter bar divides a pane, the position can be changed by selecting Change Splitter
Orientation on the RMB menu, displayed when the pointer is in the pane.

Zoom. Placing the Mouse pointer on a mass spectrum plot or spectra comparing bar-graph plot,
holding the left Mouse button down and dragging the Mouse pointer along a diagonal will result in
drawing a zoom rectangle. After releasing the Mouse button, a zoomed spectrum will be displayed; the
cursor will change to a magnifying glass. To return to the normal display, select Zoom Out from the
RMB menu or double-click.

Additional information on the Librarian and MSMS tabs is provided later in this manual under User
Libraries and MS/MS Searching.
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Spectral Analysis Utilities for NIST 17

Automated Mass Spectrometry Deconvolution and Identification
System (AMDIS)

Included as a separate utility, AMDIS attempts to reconstruct original mass spectra for individual
components in arbitrarily complex GC/MS and LC/MS chromatograms; and if a target library is
provided, AMDIS can directly identify target compounds. AMDIS is especially useful when a single
reconstructed total ion current (RTIC) chromatographic peak represents multiple components.
Regardless of each component’s concentration, pure mass spectra are deconvoluted for analyses.
AMDIS was developed by NIST under a contract from the Defense Threat Reduction Agency (DTRA),
Department of Defense, for verifying of compliance with a major international treaty (Chemical
Weapons Convention) as ratified by the United States Senate in 1997. To meet the rigorous
requirements for this purpose, AMDIS was tested against more than 30,000 GC/MS data files
accumulated by the EPA Contract Laboratory Program without a single false-positive for the target set
of known chemical warfare agents. Although this level of reliability may not be required for all
laboratories, this shows the degree to which the algorithms have been tested. AMDIS can also be
used to identify individual non-target components in complex samples. It has been widely used in the
flavors and fragrance industry, forensics, the study of natural products, and for the identifications of
metabolites.

AMDIS has been designed to reconstruct “pure component” spectra from complex RTIC
chromatograms even when components are present at trace levels. For this purpose, observed
chromatographic behavior is used along with a range of noise-reduction methods. AMDIS is
distributed with specialized libraries (environmental, flavor and fragrance, and drugs and toxins) that
were derived from the NIST 02 MS Library. AMDIS has a range of other features including the ability
to search the entire NIST 17 MS Library with any of the spectra extracted from the original data file. It
can also employ retention-index windows when identifying target compounds and can make use of
internal and external standards maintained in separate libraries. A history list of selected performance
standards is also maintained.

The instruments that are supported in their native file format are: T

Agilent ChemStation (GC-MS & LC-MS) and MS Engines
BrukerDALTONICS GC-MS (*.MSF)

Finnigan (GCQ, INCOS, ITDS, ITS-40, ITD-700/800, ITMS)
Inficon (*.acq)

JEOL/Shrader (*.Irp)

Kratos Mach3 (*.run)

Micromass (MassLynx, NT Formats) (RAW)
mzXmL/mzData

Perkin-Elmer TurboMass (RAW) and ITD-700 (*.ms)
Shimadzu MS Files QP5000 and QP5050 (*.R##)
Thermo Fisher Xcalibur (RAW)

Varian (MS, SMS, XMS)

In addition, the NetCDF format, which is supported by many manufacturers, is supported by AMDIS.
Other formats will be added in future releases. Contact NIST for future information.

T The use of specific product and trade names does not indicate an endorsement by the
National Institute of Standards and Technology. The specific file formats are supported in
order to ensure that the data is transferred to AMDIS with no information loss. The specific
formats and names are covered by the respective copyrights of the individual companies.
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MS Interpreter

A new version of MS Interpreter is being released with v.2.3 of the software. To see all the new
features, send a spectrum with a structure from MS Search to MS Interpreter (Mouse pointer on
spectrum displayed with structure, Right Mouse button click, Select MS Interpreter from the RMB
menu.) Select What's new from the Help menu.

This tool was developed to aid NIST evaluators in their analysis of mass spectra. In one integrated
program, it enables a variety of calculations on a mass spectrum, using a proposed chemical structure
if available. Spectra and structures are associated in the spectral editing component of the Librarian
tab of the MS Search Program discussed in USER DATABASES section and APPENDIX 3 of this
manual. MS Interpreter is activated for an individual spectrum with the Mouse Pointer on a Plot or
Text Information pane or by highlighting the name or structure of a compound in a Hit List and
selecting MS Interpreter on the Send To menu of the RMB menu. This action opens MS Interpreter
with the spectrum and associated structure (Figure 20). MS Interpreter can also be opened from the
Tools menu or a button on the Tool Bar. If a spectrum/structure has been opened in MS Interpreter
and then the program closed and then reopened from either the Tools menu or the button on the
Toolbar, the last contents will be displayed. If MS Interpreter is started by either of these two actions
just after starting the Program, both the Structure pane and the Spectrum pane will be empty.
Spectra can be imported from MSP files (text files containing spectra in the NIST MS Search format),
JCAMP-DX, and SDfiles. If the folder also contains a *.STB structure file that has the same name as
the MSP file, that structure will be associated with a spectrum in MS Interpreter. When a
structure/spectrum pair is Saved from the MS Interpreter’s File Menu, two files are created: one
containing the spectrum (*.MSP) and the other a structure (*.STB).

Peaks in the spectrum originating as a logical fragment of the molecule (M** or MH*) are marked at the
top of the spectrum display; and corresponding fragments, derived from thermodynamic
approximation, may be highlighted by clicking on one of these marks. It also allows for keeping track of
important neutral losses, both from the precursor or a derived ion and to find all possible formulas for
any peak or neutral loss. Isotopic patterns (Figure 21) for any cluster can be separately examined.
These isotope clusters can be compared to theoretical predictions subject to a number of user-
specified constraints. MS Interpreter is a separate program that also has an icon in the NIST Mass
Spectral Database program folder. It also has a simple Help screen that can be called from the
program by selecting Help on its Menu Bar or by pressing the F1 key. Information about the control
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Mouse button will result in a somewhat self-explanatory RMB menu. Before using the program,
explore this RMB menu (Figure 22).

Selected ions on the plot of the mass spectrum can be sent to Formula Calculator and the Isotope
Calculator using selections on this menu. A specific m/z value can be locked as the position to
display calculated losses from. In addition, the Fragment options dialog box can be displayed
(Figure 23).
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Exact masses of fragment ions
Structure view displays not only nominal m/z but also Figure 23. Fragment options dialog box.
exact mass of the predicted fragment ion.

Pasting a chemical structure into the Structure view
e Copy a structure from a structure editor (molfile format) into Windows Clipboard;
¢ In MS Interpreter, click Structure view title bar to activate it;
e Click Paste button or select from the menu: Edit/Paste or press Ctrl-V.

Pasting a mass spectrum or a chemical structure into Mass Spectrum view
Contents of a file containing a mass spectrum or a structure or both (SDfile) may be pasted into the
Mass Spectrum view.
Pasting a peak list into the Mass Spectrum view
e Copy a peak list into the Windows Clipboard;
e In MS Interpreter, click Mass Spectrum Window to activate it;

e Click Paste button, or select from the menu: Edit/Paste, or press Ctrl-V.

o the peak list must be made out of m/z and intensity pairs separated by any of the following
characters:
space ,;:()[]1}]| Tab

e each line must contain one or more m/z and intensity pairs;

o if at least one line contains an odd number of values, then the program reads only first two
numbers (one peak) from each line; a warning is displayed,;

o all peaks must be in order of either ascending or descending m/z;
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o all m/z are rounded to the nearest integer by the MS Interpreter;
e there is no need to normalize intensities to 999.

Pasting MSP, SDF, MOL, and JDX (JCAMP-DX) files from Windows Explorer

e MSP, SDF, MOL, and JDX files may be copied from the Windows Explorer and pasted into the
Structure or Mass Spectrum view of MS Interpreter.

e The files of the same type may be dragged from the Windows Explorer and dropped into the same
MS Interpreter views. In all cases, only the first spectrum and/or structure from the first selected
file is/are imported.

e The name of the imported file appears on the MS Interpreter Title Bar and in the MRU (most
recently used) list in the File menu.

Copying calculated isotope envelope table from the Isotope Calculator into Windows Clipboard

¢ Right-click any line in the Isotope Calculator table
e Select Copy.
This will copy into the Windows Clipboard a tab-delimited text, which is suitable for pasting into a MS

Excel spreadsheet or text editor. The context menu and the text contain words “Default Isotope Table”
or the name of the file from which a custom isotope composition was imported (see the next section.)

Using custom isotope composition table in Isotope Calculator and Formula Calculator

e Open file MS_Interpreter_isotope_table test 01.ithl in a plain text editor. This file is installed in
the same folder as MS Interpreter, typically, c:\nistl1\mssearch

e Read the notes in the file

e Edit the file and save it under another name

e From MS Interpreter menu, select File/Import Isotope Table

¢ Inthe Open Isotope File dialog box, select the newly created file and click the Open button.

e To restore the original table, import file MS_Interpreter_isotope_table_default.itbl. The original
table is restored automatically after both MS Interpreter and MS Search are shut down.

o Everytime a *.itbl file is imported, a *.itbl.log file is created or appended. This file contains the
date, time, a full pathname of the .itbl file, and a list of differences (if any) between the current and
the imported isotope table or a reason for the failure to import the new table.
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Example Searches

Library Spectrum and Structure Searches

The Program can be used to find spectra that are similar to that of an unknown compound. This can
be accomplished by importing the spectrum from a third-party mass spectral data analysis program,
from a text file (*.MSP), or from an MSP file that is on the Windows Clipboard. A spectrum can also be
created using the Spectrum Information dialog box displayed by selecting the New button on the
button bar of the Librarian tab to enter the m/z and intensity pairs that make up a mass spectrum. The
Library Spectrum Search and the Structure Search are usually carried out from the Lib. Search tab
by clicking on the Library Search button (Go) or Structure Search button (next to the Go button).
Another way of initiating a search is to select a spectrum in any Hit List or the Spec List, Plot pane or
Text Info pane in any tab, or in a Compare pane; display the RMB menu and click with the Right
Mouse button any spectrum in a List of spectra or Subtraction spectrum in the Compare pane; and
select the desired search (Library Search for a spectrum search or Structure Similarity Search for a
structure search). To search for more than one spectrum at once, make a multiple selection in any List
of spectra (Hit List, Spec List, or Other Search List except Name Search List), display the RMB
menu, and select Library Search or Structure Similarity Search. Regardless of the tab display,
when one of these searches is carried out, the view will change back to Lib. Search tab. In the
default display of the Lib. Search tab, the Hit List is on the lower left. The third column (from the left)
of the Hit List contains the Match Factor. Match Factor 1000 for the Structure Search does not mean
an exact match; it means that the found structure is a homologue of the submitted structure. Match
Factors for the Spectrum Search cannot exceed 999.

Spectra and structures can be imported from files or third-party programs through various types of
automations, described later in this section. Spectra or structures can be imported from a file by
selecting File from the Main Menu Bar and selecting Open from the File menu (Figure 24). Selecting
a file will result in a display of the Structure Import dialog box or the Spectrum Import dialog box.
The Structure Import dialog box is self-explanatory. The Spectrum Import dialog box (Figure 25) is
more complex. When a file containing more than one spectrum is selected, one or more selected
spectra or all of the spectra can be imported by using either the Import Selected or the Import All
button, respectively. Pressing the Import Options button will open the Spectral Import Options
dialog box (Figure 26). This is where information about the m/z values of peaks is controlled.
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Choose file for spe 2|x]

Lookin: | (=) MSSEARCH -] « & ek E-

ﬁ’_‘.’j—l Morphinan-6-0l 78-didehydro-45-epoxy-3-methoxy-17-methyl-6-trimethyisilyl}-{5alpha
i5! Test MSP

j5/COCAINE MSP

ﬂ?j" msms_spectrum . MSP

5/ CAD_Bxp MSP

5 SYNON.MSP

5 TEXTSAMP .MSP

5 SAMPLIB.MSP

File name: | | Open I
Files of type:  |NIST Text (".MSP) = Cancel |

MS Jecamp-dx (*.JDX)
Mol File (*MOL) &
SDFile (*.SDF)
MGF (*.MGF)
DTA(".DTA)

PKL (*.PKL)
mzXML (*mzXML)
mzData (*mzData)
All Files (*.)

Figure 24. File Selection dialog box with some of the available file types. MSP and JDX files are spectra,

and MOL files are structures.

x|

# | The names of spectra retrieved = Irniport All |
1 Scan Mo, 35 DEMOD
¢ Scan Mo, 95 DEMO Impont Selected |
3 Scan Mo, 131 DEMOD
4 Scan Mo, 176 DERMO |mpDr‘[ gpﬂgns |
5 Scan Mo, 192 DEMO
B Scan Mo, 206 DEMO Search Options |
7 Scan Mo, 315 DEMO —
] Scan Mo, 340 DEMOD Cancel |
g Scan Mo, 430 DEMO —
10 Scan Mo, 482 DEMO = |
. | _'|_I Help
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1004 33
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49 77
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a0 40 50 R0 70 al a0 1an 110 120

Figure 25. Spectrum Import dialog box with a single spectrum from a multiple spectrum file highlighted

and displayed in a bar-graph format.
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EI Spectrum m/z Rounding
Multiply m/fz in imported spectra by

i] and round ta the
nearest integer
Example:
(CHZ)n correction is 0, 99555

Optional
Add this term ko all miz

0 before rounding

Adding spectra to Spec List
% Prepend (add to the kop)

Tandem Spectrurn Accuracy

Precursor ion myz

4 ~| decimal places

Product ion mj'z

4 - | decimal places

In-source/EI accurate ion mfz
4 +| decimal places

Intensity threshold
™ % of max.

The two fields on the upper left of the Spectral
Import Options dialog box are used to make
mass defect corrections. The difference in the
integer nominal mass and the exact mass of an
isotope is the mass defect. The most
significant effect of mass defect is seen on the
integer mass of hydrocarbons due to the mass
defect of hydrogen. The integer mass of the 1H
isotope is 1. The exact mass of this isotope is
1.00725. The CsoHioo ion has a nominal mass

" Ovenwrite (replace)
[ absolute
" Ask

Spectra withaut precursar ion mjz value are
Accurake myz speckrum type

(the sum of integer mass of the most abundant
naturally occurring isotope of each element
times the number of atoms of those elements)
of 700, (50 x 12) + (100 x 1). The integer value
for CsoHi100 based on a calculation of the exact
mass of each of these elements is 701
(12.000000 x 50) + (100 x 1.007825) =
700.7825. The mass defect for CsoHioo is
0.7825, which is equal to about 100 millimass
units per 100 mass units. The MS Search
Program deals with only integer mass values
when searching the NIST 17 MS Library.
Spectra are imported with integer m/z values; therefore, spectra recorded with observed values of m/z,
which are not integers and have not been corrected for mass defect, must have a mass defect
correction applied to be properly searched against the NIST 17 MS Library or another library that
contains only integer m/z values.

&+ EI {nominal myz) " In-source ™ Accurate mfz

RI type if unspecified |Unspecified j

[~ Include Synonyms Set default values |

oK | Cancel | Help |

Figure 26. Spectral Import Options. Imported
spectrainteger m/z and no mass defect
correction.

The mass defect factor can be entered in the box “Multiply m/z in imported spectra by”. The factor for
hydrocarbons based on a general formula of —(CHz2)n— is 0.99888. When dealing with spectra that
have significant mass contribution from multiple atoms of chlorine or bromine (both of which have a
significant negative mass defect), a different factor should be calculated. In this case, it may be
desirous to use the field preceded by “Add following term [value] to all m/z values before rounding”.

The “Adding spectra to Spec List” box allows the permanent specification of the action when importing
spectra. Choosing Prepend will always add to the current Spec List, Overwrite will always replace the
current Spec List. Ask was the only option prior to version 2.2 of the search program.

Intensity threshold allows you to remove low intensity peaks from the spectrum as it is being imported.
This can be done in terms of relative peaks — for example 0.1% would keep peaks to 1 part in 1000 of
the base peak. Absolute will simply remove data below a user specified threshold.

Spectra without precursor ion m/z values are assumed to be El data by default, but can be changed to
be In-source/El with accurate ion m/z spectra.

RI data in input spectra are not normally characterized by type of column.
particular column type for your data you may do so here.

If you want to specify a

Finally, Synonyms may be included or excluded
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Search | MS/MS | Libraries | Automation | Limits | Constraints | Rl (GCI|

Spec arch Type

O] " Similarity
Marmal - ¥

Spectrum Search Options
[ Reverse Search

™ Match lon Mode

—

[T Penalize rare compounds

Fresearch
@+ Default © Fast

" InChikey

COOf M

blank = match search spectum InChikey

Other Options
V¥ Automation [ Auto Beport
[ Apply Limits [T Use Constraints

Stucture Similarity Search Options

¥ Match Mumber of Rings ¥ Show Homologues

o]

Cancel | Help

Figure 27. Library Search Options Search tab
for an “Identity” Normal search.

Library Search Options

Selecting Library Search Options on the Options
menu from any tab or selecting the Library Search
Options button on the button bar of the Lib.
Search tab will display a multiple-tab Library
Search Options dialog box (Figure 27).

A number of different types of spectral comparison
routines for choosing the best matching spectra are
available. The routine to be used is selected from
the Library Search Options dialog box’s Search
tab.

The two search types are Identity (with four
options) and Similarity (with five options). These
different searches and their options are explained in
the Help Screens (topic Spectrum Search Type).

The Search tab of the Library Search Options
dialog box also has a Structure Similarity Search
Options selection. This has the Match Number of
Rings check box. When selected, the search of
compounds that have rings will be constrained to
only spectra produced by compounds with a similar
structure and the same number of rings as the
spectrum being searched. The Show Homologues
selection is self-explanatory.

New in v.2.3 of MS Search is is the InChlKey presearch. This is used when the structure associated
with the spectrum is known. It is a new powerful tool that helps to find identical structures in multiple
libraries. Existing User libraries and thrid party libraries must be indexed to use this feature. Indexing is
a accomplished from the Tools menu of the main Menu. Details of the InChlKey presearch are found

in the Help file.
MS/MS

Search | M3/M3  Libraries | Automation | Limits | Constraints | R (5C] |

Available 1077335 Spectrain S Libraries

mainkib
replib
nist_msms
nisk_msms2
nist_ri

ot

Included Libs:

mainlib
replib

306623 Spectra in 2 Libraries

Spectium search

o]

Cancel | Help

Figure 28. Library Search Options Libraries tab.

The MS/MS tab permits selection of the m/z
tolerances for the precursor and product ions in
the MS/MS and In-source HiRes Search, the
option to ignore the precursor ion, and access
to a set of options specific to peptides.

Libraries

The Libraries tab (Figure 28) of this dialog box
is used to select the libraries to be included in
the Library spectrum Search. As many as
127 libraries can be searched at the same time.
This includes the NIST 17 Main Library
(mainlib) and the NIST 17 Replicates Library
(replib) and multiple user libraries as well as
other commercially available libraries from
sources other than NIST that are in the NIST
MS Search library format. By default, three
other NIST 17 Libraries are also installed: the
nist_ri, nist._ msms, and nist_msms2. This
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means that there is space to accommodate an additional 122 user libraries. If more MS libraries need
to be accommodated, the less used ones can be moved to another folder. To add libraries to be
searched in the Available Libs pane of the dialog box, highlight them and click on the Add button. To
exclude libraries, highlight them in the Included Libs pane and then click on the X button above the
upper right portion of this pane. The order in which libraries are searched can be changed by
highlighting the library to be moved in the Included Libs pane and clicking on the Up or Down arrows
in the upper right portion of this pane. Each click will move the library one position. The order in which
libraries are searched is not important because the Hit List has the 100 Highest Match Factor Hits
regardless of what library they came from.

Below the Available Libs and Included Libs panes is a drop-down list box. This box allows for
switching between the lists of libraries to be included in Structure searches or Spectra searches.

These two different types of searches can have different sets of libraries.

Retention Index Data

The retention index search options are generally only available when the search spectrum has a
retention index (RI) value in the submitted spectrum. The Ri value is taken either from a line in the
MSP file of the format

RlI=value
or from the corresponding text in comment section of the MSP file.

The use of the RI data is controlled by the RI(GC) tab in the Library Search Options dialog box
(Figure 29). If the “Use Retention Indices...” box is checked, then the program will compare the RI
data in the submitted spectrum to the RI value in the library spectrum. The comparison will only be
made if the type of column for the search spectrum and the library spectrum are the same.

x|| In general, the data will not have the
column type specified so it the
specification can be made at the time
the data is imported. Alternatively, if
Select Rl Column Type for Searching or Displaying the search spectrum column type is not
¢ Standard Non-Polar (.. DB-1) explicitly stated, the program will
( Semi-Standard Mon-Polar fe.g. DB-5) assume that it is the type specified in
the box “Select RI column Type for
Searching or Displaying”.

Search ] MS/MS ] Ublaries] Pd.rlnmationl Limits ] Constraints BRI {GC) l

r iUse Retention Indices (RI) comparnson for Lib. Search
Match Factor comection

" Standard Polar (e.g. DB-WAX)

The normal mode of operation will
[ Column type specified in search spectrum will overide selection restrict the search to data of the same

W Use other non-palar column type data f selected non-polar type data is column type' However’ since th_e .tWO
absent non-polar types are somewhat similar,

v Ejg{;‘gfgjjﬁfﬁp‘e‘“h B e the program has the option to allow the
use of the other polar type if the

Rl tolerance 10 specified type is not present. NOTE: If
Rl penalty rate Average |- there is both standard (DB1) and semi-

standard(DB5) non-polar data, and you
have specified the DB5 data, it will be
used. The DB1 data will only be used if

’Tl Cancel Help a specific library spectrum doe§ ngt

have data for DB5. No such option is

Figure 29. Tab dialog for specifying RI criteria for search available for the polar column data. To
and display. select the option to use the alternate

non-polar type check the box next to
Page 32 NIST 17 MS Database and MS Search Program v.2.3



“Use other non-polar column...” below the Select Rl Column box.

When indexing a user library, the option exists to specify the column type. If it is not specified and the
column type of the individual RI values for spectra in the library are not specified, then the column type
will be set to “User” or unspecified. In this case, you must check the last option to ensure that the RI
data in the user library is correctly processed.

A brief note on the values of RI tolerance and RI penalty rate: The RI variation within a set of data
taken using basically the same protocols and generally similar matrices will vary by a very small
amount, typical standard deviations are in the range of 2-3 Rl units. The median variation (that is the
median of the uncertainty (median absolute deviation) of the data in the NIST RI library is over 6 RI
units. Thus, the data in the NIST library may be at greater variance from your experimental data. For
this reason, the recommended RI tolerance is high and the penalty rate is low.

The use of both non-polar data sets, while expanding the range of RI data must be done with care.
Looking at all the data in the collection where there are both DB1 and DB5 data, the DB5 data is about
0.74% greater than the DB1, that is RI(DB5) =1.0074*RI(DB1). This is a small variance, but at a RI of
2000, it corresponds to a difference of 14.8. In addition, the scatter in the correlation data is large. If
the RI tolerance is 10 and the wrong column type is being used since the correct one is not available,
there may be too much penalty.
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Automations

When a Library spectrum Search or a Structure Search is carried out on a spectrum or a structure
that is imported from a file or third-party program such as an instrument data system or drawing
program, a search can be automatically launched. Automatic searching and/or printing can be turned
on or off from the Search tab of the Library Search Options dialog box by the respective selection or
deselecting of the appropriate check box (Figure 27 and Figure 30).

The Automation tab of the Library Search Options dialog box is used in conjunction with these
automated searches (Figure 30). Check box Automatic Search On (Figure 30) has exactly same
functionality as Automation check box on Figure 27: turns on automatic searching. Selecting or
deselecting this check box on either tab toggles the check box on the other tab.

Search results can automatically be printed whether or not

_ = the search is automatically launched. Check box Auto

Search] MS/MS] Libraries  Automation ILimns ] Constrairts] . . « .
Report (Figure 27) turns on this feature. “Number of Hits
Number of His to Print 2 to Print” field is in the Automation tab (Figure 30). In
I Include Spectrum Plot in Report addition, the report in the same format can be printed for

¥ Draw Structure in Plots

n ispl rch resul lecting Print A
AN any displayed search result by selecting t Auto

Report from the File menu.

The top part of this dialog box pertains to the automated
printing of a search result. The format for the Auto Report
is a sample spectrum at the top of a page followed by the
spectra of a specified number of Hits in the “Number of
Hits to Print” numeric entry box (2 by default). If the
Include Spectrum Plot in Report check box is selected,
there will be three spectra per page. Page one will have
the sample spectrum at the top followed by the first two
Eoor e Hits. Selegting the Draw Structur.es in Elots check box

will result in the structure associated with a spectrum
Figure 30. Lib Search Automation tab. being printed in the plotted spectrum.

If the Apply Maximum Spectrum Length check box is
selected, a number can be entered for the maximum m/z value to appear on the spectrum’s abscissa.
If peaks are present at higher m/z values, the abscissa will have a right-pointing arrowhead at its right
end. When selected, the Return Focus to Caller Upon Completion check box will cause a program
that brought the NIST MS Search Program into focus if already running, or started if not already
running, to again be visible after the search.

Limits

The function of the limits of the starting and ending m/z values of a Library spectrum Search and the
lowest value of a mass spectral peak that will be considered in a search can be set. An explanation of
the limits that can be used to constrain a search may be found in the Help file by selecting the Help
button on the Limits tab of the Library Search Options dialog box.

Constraints

A Library spectrum Search can be constrained by a number of factors such as what elements (and
how many atoms of each) must be present in the compounds that produce retrieved spectra, the
molecular weight (nominal mass) range of Hits, whether or not the compounds that produce retrieved
spectra are in various other (non-mass-spectral) libraries, what m/z value peaks must be present
(along with a range of their relative intensity) in retrieved spectra, what name fragments must be
associated with retrieved spectra, what text strings are in the “Comments/Contributor” field of a
retrieved spectra, and new to v.2.0g of the MS Search Program: an Exact Mass Constraint used
instead of a molecular weight range. These constraints are explained in the Help file, which is
displayed by selecting the Help button on the Constraints tab of the Library Search Options dialog
box.
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The Search Menu (displayed by Selecting Search on the
Menu Bar)
The Other Search tab’s options are:

Option Description Tab View

MW (Nominal Mass) | Finds spectra in selected libraries of compounds having Other Search
specified (nominal mass) molecular weight (excludes replib).

Exact mass Finds spectra in selected libraries of compounds having an exact | Other Search
mass corresponding to specified accurate mass with a specified
variance (excludes replib).

MS/MS Precursor New in v.2.3. Searches for Precursor m/z using precursor-ion Other Search

m/z mass, formula, m/z values within the uncertainty interval in
MS/MS Libraries

Formula (Elemental | Finds spectra in selected libraries of compounds with specified Other Search

Composition) formula (excludes replib).

Any Peaks Finds spectra in selected libraries based on user-specified Other Search
peaks.

Sequential Method Searches selected libraries using a set of constraints provided by | Other Search
the user.

CAS Number Finds spectra of the compounds that have the entered CAS Other Search

registry number.

ID Number Finds spectrum (or spectra) in selected library having entered ID | Other Search
number (or range of ID numbers).

NIST Number Retrieves a spectrum with unique NIST Mass Spectral Data Other Search
Center’s Archive ID number (in mainlib and replib only).

Name Allows entering a character string to display spectra beginning Names
with name of a compound.

These options (except for the Name search) are also displayed and may be selected from the
drop-down list box on the further most left side of the Other Search tab (to the right from the
binocular button). Selecting the binocular button starts the currently displayed search in the drop-
down list box.

Each Search has its own dialog box. When the MW (Nominal Mass) Search, Formula Search, or
Sequential Method Search is selected, the dialog box opens to the Constraints tab (Figure 31). The
MW (Nominal Mass) Search and the Formula Search dialog boxes have specific entry fields for
entering a nominal mass and elemental composition, respectively. Certain obvious constraints are not
available (appear grayed in the constraints list and cannot be selected), such as “MW range” and
“‘Exact Mass” in the MW (Nominal Mass) Search dialog box and “Element Values” and “Elements
Present” in the Formula Search dialog box. These three dialog boxes have two tabs. The other tab is
the Options tab (Figure 32), which allows for the selection of the libraries to be searched. Even
though it is present, the replib cannot be selected for a MW (Nominal Mass), an Exact Mass, or a
Formula Search. Spectra from the replib for these searches automatically appear as replicate
spectra in the Hit List.

The maximum number of Hits allowed in the Hit List can be specified in the Options tab of the
Sequential Method Search. There is also a limit on the maximum number of Hits that can be in a Hit
List of an Any Peaks Search (settable in the Peaks tab). The Lib. Search Hit List is limited to 100
Hits. There is no limit to the number of Hits that can be in a MW (Nominal Mass), an Exact Mass, or
a Formula Search.
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Search by Any Peaks

Select Any peaks from the Other Search tab’s Search menu or the drop-down list box. This will
display the Any Peaks Search dialog box (Figure 33). Click the “m/z” field (located below the m/z
drop-down list box). The blinking vertical text cursor will now appear in “m/z” field. “Normal” will be
displayed in “Type” field. Type 149 and press <Enter>. This moves the cursor to the “From” field. Type
75 and press <Enter>. This moves the cursor to the “To” field. Type 100 and press <Enter>. This will
enter the peak with its type and intensity range. The cursor is now in the “m/z” field.

Note that the option of the total number of hits will default to 100, but can be set to a maximum of 1000.

Options  Constraints l Optiong ] Constraints

[V Use Constraints Clear Al I

Enter Chemical Formula: Ic7H1 20

b ax Murn of Hits {100

A ailable 1077335 Spectrain 5 Libraries

mainlib
replib
nisk_msms
nisk_msms2
nisk_ri

| IPeptide Seauence

oo

Included Libs: s

mainlib
replib

Djerassi =

= 306623 Spectra in 2 Libraries
Exact Match Other Match No Match
Tag = "string”  Tag =substing Tag = ™'string”

Tag=123 Tag = 12:34 Tag = “substring
Tag > 1.234 Tag = "12:34

| Search I Cancel Help
Search |

Cancel Help
Figure 31. Formula Search dialog box with Use
Constraints selected and a Tag in Constraints Figure 32. Options tab of the Sequential Method
entered to yield only spectra contributed by Carl Search dialog box showing that a maximum of 100

Djerassi. Hits will be displayed.

Page 36 NIST 17 MS Database and MS Search Program v.2.3



x|
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Figure 33. Peaks tab of the Any Peaks Search
dialog box showing the selection of the four
different types of peaks and intensity ranges.

Put the mouse pointer on the ¥ on the right side
of the “Type” field and click the left Mouse
button. Put the Mouse pointer on “Loss” in the
displayed menu and click the left Mouse button
again. This will cause the cursor to reappear in
the “m/z” field. “Loss” will be displayed in the
“Type” field. The first peak entered is an
observed peak in the mass spectrum, and it is
possible that it is the base peak. The second
peak entered represents an ion formed by a loss
from the molecular ion. Type 0 and press
<Enter>. Type 1 and press <Enter>. Type 25
and press <Enter>. The retrieved spectra must
have a peak representing the molecular ion peak
that exhibits an intensity between 1% and 25%
of full scale. This reduces the number of spectra
in the NIST/EPA/NIH Mass Spectral Main and
Replicates Libraries that match the entered
criteria from 4025 for the first peak to 1302 that
have both peaks

The next peak will be a “Maxmass” peak. Click
on the W on the right side of the “Type” field.
Click on “Maxmass”. Type 300 and press
<Enter>. Type 1 and press <Enter>. Type 25
and press <Enter>. There will only be 17 spectra
that contain all three peaks of the designated
type and over the designated intensity range.

New in v.2.3 are peak types of Accurate MZ and Accurate Loss. For more information on these two
types of peaks, put the Mouse pointer on the Help button in the Any Peaks Search dialog box and

Click the Left Mouse bottom.
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NOTE - USER LIBRARIES ARE NOT SEARCHED USING ANY PEAKS EXACT MASS

The Any Peaks Search can also perform searches on Exact Mass of the fragments. However, this
search mode only works on the NIST libraries; it will not function on user libraries even if the user
library has been indexed by exact mass. The exact mass indexing of the user libraries done through
the Tools/(Re)Index Exact Mass only indexes the precursor or molecular ion based on the formula.

i Figure 34 is the Any Peaks Search dialog box

set to accept an accurate mass value with
Peak | Libaries | Constaits | variance. It is important to remember that the
[ ' “Exact Mass” Any Peaks Search is only valid

Type:
for monoisotopic peaks (all atoms of all
|ExactMass 'I

elements in the ion represented by the peak are
[Uncertainty mmi 7] |’5_ the most abundant isotopes). Do not try to
enter values for peaks that contain higher mass
isotope of chlorine (3Cl), bromine (8°Br), or

fccept | : l Gearal other elements. An accurate mass (Mass), an
Type | m/z | From | | Peaks | Hits | m/z value (adjusted for electron mass), or an
E 149.1345s5mmu 10 |1 22726 elemental composition (Formula) can be
N 238 17 2 27
entered.

The uncertainty can be in millimass units (mmu)
or parts-per-million (ppm). If this field is left
4 | | blank, an uncertainty of 0.5 less than the last
P_j digit entered for the mass is assumed. In this
case the uncertainty always is a 0.5 value; i.e.,
the uncertainty for 120.00 is +0.005 and
120.000 is +0.0005.

Peaks required:

[~ Use Constraints Max Num of Hits IWD

Seach | Cancel |  Hep |

To enter a chemical formula, select formula in

Figure 34. Any Peaks Search dialog box, the drop-down list box above the first entry field
shqwing an entry of an a_c_curate mass value with (this is possible only if “Exact Mass” type has
variances. Note the position of the slider bar. been selected.) If the “Uncertainty” field is left

blank, the accuracy of searched mass is exactly
the same as the accuracy of the mass saved in the library. It is very rare the exact mass of two
different elemental compositions is the same; therefore, there is a high probability only the spectra
where the peak was interpreted with the same elemental composition will be found. Molecular ion
peaks in the mass spectrum will give very good results when used for the Any Peaks Search Exact
Mass option; however, caution must be taken when using the accurate mass of fragment ions. The
exact mass values in the NIST DB are calculated from the elemental compositions of ions predicted by
MS Interpreter where peaks are present in the mass spectrum. More than one exact mass may be
saved in a library for a peak in a mass spectrum of a compound. For instance, both CO and C2Hs may
be assigned to the same peak with m/z 28. Searching for these two "Formulas” would produce a
number of Hits containing both peaks. These Hits correspond to mass spectra where the peak at m/z
28 was ambiguously interpreted. The Any Peaks criteria can be used in the Sequential Method
Search or as a constraint with a MW (Nominal Mass), Exact Mass, Formula Search or with a
Spectrum Search; however, the “Exact Mass” Peak type is not available for these searches. When
Peaks is used as a Constraint, relative intensity can be specified. In this case, the subsequent peaks
have intensities relative to the first peak. Thus, if the first peak has an intensity between 50 and 100%
of base, the second peak can be specified to have an intensity of between 40 and 200% of the first
peak. This is especially important when using SIM (selected ion monitoring) searches and wanting to
understand the rates of false-positives. Radio buttons appear at the bottom of the Peaks Constraints
dialog box to switch back and forth between “Absolute” and “Relative” (1st Peak is Special !).
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Exact Mass Search

Exact Mass Search can be used directly to search the NIST libraries. In addition, Exact Mass
(alternately with nominal mass) can be used as a Constraint in User Spectra Searches (Lib. Search
tab), Any Peaks Search, and Sequential Search (Other Search tab).

NOTE — THE EXACT MASS CONSTRAINT IS FOR MOLECULAL OR PRECURSOR ION MASS

Select Exact Mass from the drop-down list box
on the upper left of the Other Search tab. The
three-tab dialog box shown in Figure 35 will be
displayed. The exact mass value to be searched
is entered into the “Search value” field on the
Accurate Precursor Mass Search tab of the
dialog box. The “Type” of the value is selected
from the drop-down list box next to the “Search
value” field. All the fields in the dialog box are
explained in detail by selecting the dialog box’s
Help button. The Libraries tab allows the
selection of the libraries to be searched. Like the
MW (Nominal Mass) Search and the Formula
Search, the NIST 17 replib is not available for
searching. The Constraints tab allows the
Exact Mass Search to be constrained by
presence in other databases, name fragment,
Tags in the “Comments/Contributor’ field,
elements present, and element values. In
addition, the formula or the formula for the
neutral loss can be entered. In this case, the
program will calculate the exact mass and use
the uncertainty (if provided).

The Exact Mass Search is not restricted to

Accurate Precursor Mass Search I Libraries ] Constraints ]

™ Use Constraints
Search for precursor mass

Mass, m/z or formula Select type

| Search value ,W m/z >
Uncertainty™ |5 ppm v
| Charge |1

*fields may be left blank
[~ No electron mass comection in calibration;

Find
¥ Monoisotopic precursor mass

" Among |2 'I most abundart isotopes

o]

Cancel Help

Figure 35. Exact Mass Search’s dialog box.

the NIST/EPA/NIH Libraries; however, user or other non-NIST libraries must first be indexed by the

| (Re)i x|

[CIMAINLIB

[ n-propyl ethers

[CINIST_MSMS

[CINIST_MSMS2

CINIST_RI

Libraries in upper case are probably up to date out.
Cancel |

Figure 36. Dialog box to allow for
indexing databases according to exact
mass.

NIST 17 MS Database and MS Search Program v.2.3

exact mass. Select Tools from the Main Menu and then
select (Re)Index Exact Mass. This will result in a dialog
box being displayed (Figure 36). The time to index a
library will depend on the size of the library. All NIST 17
Libraries are already indexed by the exact mass.

After the desired libraries have been indexed (this has to
be done only once), an Exact Mass Search or another
Search using Exact Mass as a Constraint can be carried
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Search by Name - Browse

The data in a library can be searched or browsed using the incremental name search (the Names
tab). As a name is entered, the program finds the next name that fits all the text typed to that point.
The names search works over not only the primary name but all synonyms. This means that common
names for chemicals can be quickly searched. Some common compounds have a very large number
of synonyms. Once the name is found highlight the desired name, and the display in the Plot/Text
and Plot Windows will be refreshed with the appropriate display for the compound.

Use the Mouse pointer to place the blinking vertical text cursor in the “Name” field at the top of the
Name Search tab. To search for the mass spectrum of a plant growth regulator, GIBBERELLIN A9,
begin typing the name. Stop after entering each letter. After the letter N has been typed, the 13t name
in the Hit List pane is the target. Names may also be pasted from the Windows Clipboard into the
“‘Name” field by simultaneously pressing keys Shift and Insert or using the RMB menu’s Paste
selection.

NOTE: This feature can be used in a user library to give synonyms such as “LabBook05-Pg6” or more
simply “B05-P06”, this allows the data to be quickly found by reference to the original experiment.

Sequential Method

This method allows every spectrum in the selected libraries to be subjected to a created search
criteria. The criteria that are set in the Constraints section govern the Hit List returned. In this search
method, it is possible to use not only absolute but also only relative intensities of peaks. This can be
an important tool for examining the risk of false positives when using SIM searches.

In the example shown in Figure 37, the peak at 109 is allowed to be present in a range of 1 to 100% of
the base peak. The subsequent peaks (158 and

= = 63) are sought as a fraction of the 109 peak,
Options  Constrairts | regardless of the intensity of the 109. If the peak
IV s Coemsia Clear Al | with m/z 109 is 15% of the intensity of the base
MW (Nominal Mass) = peak and the peak with m/z 158 is 5% of the
[]Exact Mass intensity of the base peak (i.e., 33% of the 109) it
[IName Fragment j would be accepted. This kind of analysis can

[ 1Elements Value . . o ] )
[ |Elements Present give important insights into to risk of false

positive matches when using SIM (selected ion

R - : = monitoring) in GC/MS experiments.

Type: m/z: From: To:

[Nomal =] I | | In SIM, the entire spectrum is not seen so the

Ty e e relative intensities of the ions observed are the
Accept | Delets | Clear all | only data that can be extracted from the data file.

Type m/z From | To NOTE: All the other methods of searching are

N 109 1 100 also present in the Sequential Method. The

N 158 10 35 . o

N 63 20 50 elements search can also be interesting if the

number of compounds in all the libraries that
have at least one mercury atom in the molecule
needs to be determined. On a modern computer
with a large amount of memory these searches

Mode: ™ Absolute (' Relative (1st Peak is Special !)

,Wl Cancel Help do not need to take very long. Typically any

sequential search will be faster for subsequent

Figure 37. Sequential Search dialog box similar searches because much of the data file
showing the use of Any Peaks in a Relative will be cached in the computer memory.

mode.
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Basis for Interpretation of the Library Search Results

When an Identity Search with an unknown spectrum (Library spectrum Search) is performed, the
results will be associated with three numbers for each spectrum shown and one value for the search.
These three numbers are: 1) a Match Factor for the unknown and the library spectrum (direct match
of peak m/z values and relative intensities), 2) a match factor for the unknown and the library spectrum
ignoring any peaks in the unknown that are not in the library spectrum (Reverse Match), and 3) a
Probability value (column headings in the Lib. Search Hit List; Match, R. Match and Prob.,
respectively). The first two numbers are straightforward. Each is derived from a modified cosine of the
angle between the spectra (normalized dot product). A perfect match results in a value of 999; spectra
with no peaks in common result in a value of 0. As a general guide, 900 or greater is an excellent
match; 800-900, a good match; 700-800, a fair match. Less than 600 is a very poor match. However,
unknown spectra with many peaks will tend to yield lower Match Factors than similar spectra with
fewer peaks. The Probability value and the value for the search (InLib, located in the lower right
corner of the Hit List pane and on the Title Bar of the Lib. Search tab) require more explanation.

The Probability value for a Hit is derived if the compound is represented by a spectrum in the libraries
searched. It employs only the differences between adjacent Hits in the Hit List to get the relative
probability that any Hit in the Hit List is correct. This value is derived from an analysis of the results of
searching the NIST/EPA/NIH Main Library with a set of replicate spectra (given in the Replicates
Library). The relative probability of each of the Hits requires only the difference values because the
total probability of the compound being in the searched libraries is assumed to be one. The other
factor (InLib) is a measure of the probability of the compound being in the searched libraries. This
value is also derived from the same set of replicate spectral searches. In this case, the correct
compound was ignored in the Hit List; and the difference between the Hit List, with and without the
correct compound, is parameterized. The parameters are the maximum value of the match and the
largest single difference among the top 20 Hits. If the first Hit has a high Match Factor (>900) and the
next Hit has a Match Factor of 800 or less, the probability of the compound being correctly identified is
very large and the probability of the compound being in the searched library is large (the number of
“Hits vs. their Match Factors” is displayed in the Hit Histogram pane located just above the Hit List,
see Figure 3).

Like all statistical results, these probability calculations rely on the data sampled. For example, if a
compound that has very few similar mass spectra will be identified in a more definitive way (a higher
Probability and InLib value). Using examples from the Replicates Library and searching the Main
Library using a compound like ‘folpet’, will result in a high probability for the first Hit and a high InLib
value. In contrast, if replicates of 'cyclohexanol' are searched, the results will be much lower
Probabilities and InLib value; and, in some cases, the best Match is not even the correct compound.
This reflects the fact that there are very few compounds that have mass spectra similar to ‘folpet'; but
there are a number of compounds that have very similar mass spectra to 'cyclohexanol', and the ability
of any search system to distinguish between these similar spectra is limited. In many cases, the best
that the search can do is to provide a class of compounds that have similar mass spectra and, usually,
similar structures.

The values of the InLib parameter are meant as guideposts. Generally, any positive value is
acceptable. Values greater than approximately 300 usually mean that the spectrum is nearly unique.
Negative values below 200 are generally a warning that the spectrum is not identified. Note that
negative values will occur when there are many compounds with similar spectra. In these cases, the
difference between the Match Factors for different spectra is very small, and the search cannot be
assured of providing the correct uniqgue answer. Usually in these cases, especially when Match
Factors are high, it will provide very good guidance on the structure of the molecule.

For a complete discussion of the methods used in assessing the probabilities, see Stein, S.E.
“Estimating Probabilities of Correct Identification from Results of Mass Spectral Library Searches” J.
Am. Soc. Mass Spectrom. 1994, 5, 316-323.
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Substructure Information

The Substructure Information utility is used in the evaluation of a Hit List using the NIST/EPA/NIH
Mass Spectral Library because each spectrum is indexed by the substructures that make up the
structure of the compound that resulted in the spectrum. Substructures are functional groups like
carbonyls, methoxys, methyl ester moieties, etc.; the number of rings and double bonds; and
heteroatoms.

The Substructure Information is most useful when the Hit List is the result of one of the four
Similarity Searches (Simple, Hybrid, Neutral Loss, MS/MS in EI). This utility is called from the
Main Menu Bar’s Tools menu.

Similarity Searches are carried out when it is believed that a spectrum of the unknown compound is
not in any of the searched libraries. Spectra similar to the searched spectrum make up the Hit List.
There is no Prob column in the Hit List and an InLib value is not determined. Not only is the utility
useful in determining the structure of an unknown based on its EI mass spectrum, it has proved to be
very informative in the analysis of collision-induced dissociation (CID) spectra obtained from ions
produced by soft ionization LC/MS techniques such as APCI, APPI, and electrospray. This use is
described in more detail below.

The Substructure Information dialog box (Figure 38) has the hame of the spectrum that was used to
create the Hit List displayed at the top. Just below the “Name of Unknown” field in this dialog box is
the “Chlorine/Bromine information” field, which gives the probabilities and numbers of atoms of
chlorine and/or bromine present (useful regardless of the method by which the spectrum was
obtained). The result of

| Substructt X ) o
L ' | molecular weight estimation
e ok Ui — from the Hit List is presented
Component at scan 372 (6.196 min) [Model = +83u, -97u] in C:\DATA\MSDA" on the right side of the dialog
- Chlorine/Bromine information (e box (useful for El spectra,
Cl=2, Br=0 Probability=53% v | Frob. {4 .
Additional CIBr clusters were not found to confimm solution 83 50 ‘ fespemally .When o molecular
118 21 ion peak is observed). There
82 2 —l;] are two panes below this in an
‘ ] » area labeled Substructure
- Substructural information - Set of Substructures in use information: Prob. Present
Prob. (%) | Presen=] [ Prob. (%) | Absent=] || | # | Substruct.2] and Prob. Absent. These two
99 cl 99 PhCsal 1 OH . .
99 aer | |99 PhCO 2 COM panes contain a list of
39 haloge 95 PhOC. 3 AOH abbreviations for the
nocych gg g';f'! g gSH substructures preceded by a
/4mn . .
99 ol 6 20H number,_ which is the percent
95 Ctert 99 cond 7 SiH3 probability for the presence or
94 sat 99 OCH2. 8 CH3
n f th r re. If
2 il | B b ; A a 322601? Th?e z:\birst::L\J/ti)aSttiouncstuise not
T | ||| PO R weaions i
Syl chiod : ‘ — understood, highlight it by using
P S 1| ———Stgmﬁ—J the Mouse and a detailed
explanation appears at the
| OK | Print l Help | bottom of the Substructural
information area.
Figure 38. Substructure Information dialog box. Just below the molecular

weight information is the Set of
Substructures in use pane with a list box and a Customize button. The list box displays all the
substructures in the current set.
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The Customize button, when selected, displays the Customized set of Structures dialog box (Figure
39). This dialog box is used to create a subset of the substructures to be identified. The list of all
possible substructures is displayed in the Full set of structures pane. The list of substructures
included in the present file is shown in

—
4 X the Customized set pane. The first time
Full set of structures: Customized set: a_CUStomﬁzed list is Cr?ated’ both panes

Y T 3 | ¥ | Stucure B will contain the same list. Substructyres
1 OH A AL 1 OH may be omitted from the Customized
g 2002: _Thdd A | § 2%2: set pane or added from the Full set of

I i . .
4 ROH 4 ROH structures pane. Either action occurs on
5 SH 5 SH the structures highlighted by Mouse
6  ?0H 6  70H . ) .
2 GH3 2 SH3 action in the panes by selecting the
8 CH3 : z I 8 CH3 appropriate button € Omit € or = Add
?0 ETEO)OH __{ﬂ ?0 f:éo)o,_i 3 =>. The usual Windows conventions for
. » <-Omit All-< I J | _rl . . .
selecting multiple items apply. After
selecting the first substructure of the list,
K | Open | see | el | cancel | hold down the <Shift> key while
selecting the last substructure. This will
Figure 39. Customized Set of Structures dialog box. select all substructures between the first

and last. Multiple  noncontiguous
substructures can be selected by holding down the <Ctrl> key while selecting each desired
substructure.

The Save and Open buttons allow the saving and retrieving of customized substructure sets. A
temporary set is created by making modifications to the Customized set pane and selecting the OK
button. This dialog box, as well as the Substructure Information dialog box, has a Help button,
which displays a context-sensitive Help screen.

The algorithms used in the substructure identification are described in the Help screen. They are
based on developments at NIST (Stein, S.E. “Chemical Substructure Identification by Mass Spectral
Library Searching” J. Am. Soc. Mass Spectrom. 1995, 6, 644—655).
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Example of the Use of Substructure Information in Making
Determination about an Unknown Mass Spectrum obtained
by using CID

The mass spectrum in Figure 40 of a compound with the structure shown inserted in the spectrum was
obtained using collision-induced dissociation (CID) on a protonated molecule with m/z 248. An El in
MS/MS Similarity Search was performed against the NIST 17 mainlib with m/z 248 designated as
being the precursor ion. This type of search is provided to allow for the use of the vast amount
of information in the EI Library with spectra that are produced by LC/MS CID. The El in
MS/MS Similarly Search has been optimized for this purpose. The resulting Hit List was
evaluated using the Substructure Identification utility. Based on this evaluation, it was determined
that there was a 90% probability that the compound contained one or more atoms of oxygen; a 90%
probability that there was a carbonyl group; an 89% probability that there was a heterocyclic ring; and
an 88% probability that there was an aromatic ring; but it also revealed a 99% probabili